Table of Contents

Introduction ....................................................................................................................................2
Overview of the User Interface .....................................................................................................2
Creating a New Project ..................................................................................................................3
Working with Tasks .......................................................................................................................3
   Creating a Manually Scheduled Task .........................................................................................3
   Creating an Automatically Scheduled Task ................................................................................4
   Linking Tasks .............................................................................................................................4
   Creating a Summary Task ...........................................................................................................5
   Updating Task Progress ............................................................................................................5
Working with Resources .............................................................................................................6
   Adding a Work Resource ...........................................................................................................6
   Changing a Resource’s Work Hours ..........................................................................................7
   Assigning a Resource to a Task .................................................................................................7
Scheduling .......................................................................................................................................8
   Changing a Project’s Work Hours ..............................................................................................8
   Setting a Scheduling Constraint ...............................................................................................10
   Assigning Multiple Resources to a Task ...................................................................................10
   Creating a Work Exception .......................................................................................................11
**Introduction**

Microsoft Project 2013 is a project management program that is designed to assist managers to more effectively manage their projects. It gives users greater power over their projects by allowing them to simplify such things as defining work resources, assigning tasks to workers, visualizing a project, and managing a budget. This handout covers the essentials of Project 2013. It provides a brief overview of the user interface and covers creating and linking tasks, adding resources and assigning them to tasks, and scheduling. This handout uses the planning and development of a website as a project example.

**Overview of the User Interface**

Like the other Microsoft Office 2013 applications, Project 2013 incorporates the Ribbon, Quick Access toolbar, Backstage view, and context-sensitive menus and toolbars. These all make working with Project 2013 more familiar and intuitive.

The default view in Project 2013 is the *Gantt Chart* view (see Figure 1). It has two main areas: the task table (left side of the view) and the timescale (right side of the view). The *task table* lists the project tasks and their accompanying information. The *timescale* displays task bars that correspond to the tasks listed in the task table. The task bars show the duration of each task, from their planned start date to their planned finish date, over time. You can move the separator bar between the timescale and the task table to the left or right to display more of either area. The *timeline* provides a graphical view of a project along a single left-right axis.

![Figure 1 – Project 2013 Program Window](image)
Creating a New Project

When creating a new project, you can start with the default blank project, or you can base your new project on an existing project or template.

To create a new project:
1. Click the **Start** button, click **All Programs**, click **Microsoft Office 2013**, and then click **Project 2013**. The **Start** screen appears (see Figure 2).
2. In the right pane, click **Blank Project**. A new, blank project opens in the program window in the **Gantt Chart** view.

**NOTE:** You can create a new blank project at any time by clicking the **File** tab on the **Ribbon**, clicking **New** in the left pane, and then clicking **Blank Project** in the right pane.

![Figure 2 – Project 2013 Start Screen](image)

Working with Tasks

Most projects begin with a list of the tasks that need to be completed. Once you create your task list, you can then define the relationships between the tasks. Tasks can be automatically or manually scheduled, depending on the needs of the project and the information currently available. At any point during a project, you can change a task from manual scheduling to automatic scheduling, or vice versa.

Creating a Manually Scheduled Task

By default, all new tasks in Project 2013 are set for manual scheduling. With manual scheduling, you can fully control the task’s duration, start date, and finish date. The duration can be entered in minutes (m), hours (h), days (d), weeks (w), or months (mo). Manually scheduled tasks are marked with the pushpin icon 🔄 in the Task Mode field.
To create a manually scheduled task:

1. In the first row of the task table, enter **Website Ideas and Mockups** in the **Task Name** field (see Figure 3).
2. Enter **1w** in the **Duration** field. This sets the duration of the task to one week.
3. Enter **Monday** in the **Start** field. Project 2013 automatically calculates the finish date using the given information and fills in the **Finish** field. Also, a task bar appears in the timescale (on the same row as the task) showing the task’s time frame.

![Figure 3 – Manually Scheduled Task in the Task Table](image)

**Creating an Automatically Scheduled Task**

With automatically scheduled tasks, you can have Project 2013 calculate dates and durations. Automatically scheduled tasks are marked with the Gantt bar icon 📈 in the Task Mode field.

To create an automatically scheduled task:

1. In the second row of the task table, enter **Preparation & Planning** in the **Task Name** field (see Figure 4).
2. Click in the **Task Mode** field, click the down arrow that appears, and then click **Auto Scheduled**. By default, Project 2013 assigns the task an estimated duration of one day and automatically fills in the **Duration**, **Start**, and **Finish** fields. Also, a task bar appears in the timescale showing the task’s time frame.
3. To change the duration of the task to two days, enter **2d** in the **Duration** field. Project 2013 recalculates the finish date and updates the **Finish** field.

![Figure 4 – Automatically Scheduled Task in the Task Table](image)

**Linking Tasks**

When you link tasks, you create a relationship between them called a **task dependency**. Project 2013 supports four types of task dependencies. By default, Project 2013 creates finish-to-start links, which means the first task needs to finish before the second task can start.

To link tasks:

1. In the third row of the task table, create a new manually scheduled task named **Website Draft #1** and set the duration to two weeks by typing **2w** in the **Duration** field. Leave the **Start** and **Finish** fields empty.
2. In the **Task Name** column, click to select the first task, and then hold down the **Ctrl** key and click to select the remaining two tasks.

   **NOTE:** The order in which the tasks are selected is important. It defines the order in which the tasks are linked.

3. On the **Task** tab of the **Ribbon**, in the **Schedule** group, click the **Link the Selected Tasks** button 🖉. Project 2013 fills in the **Start** and **Finish** fields of the **Website Draft #1** task and links the three tasks by adding link lines between the task bars in the timescale.
4. To see the advantage of automatically scheduled tasks, change the duration of the Website Ideas and Mockups task to 2 wks instead of 1 wk. In the timescale, notice that the start date of the automatically scheduled task, Preparation & Planning, was automatically adjusted. The start date of the manually scheduled task, Website Draft #1, was not automatically adjusted and will need to be adjusted manually (see Figure 5).

5. Change the duration of the Website Ideas and Mockups task back to 1 wk.

![Figure 5 – Linked Tasks in the Timescale](image)

### Creating a Summary Task
When organizing the tasks for a project, you can group tasks that share characteristics or that will be completed in the same time frame under a summary task. By default, the summary tasks are bold and outdented, and the subtasks are indented beneath them.

To create a summary task:

1. In the Task Name column, drag to select all three tasks.
2. On the Task tab of the Ribbon, in the Insert group, click the Insert Summary Task button. Project 2013 inserts the new summary task above the three tasks, fills in the Task Name field with the text <New Summary Task>, and turns the three tasks below it into subtasks.
3. Enter Website Upgrade in the Task Name field of the summary task (see Figure 6).

![Figure 6 – Summary Task with Three Subtasks](image)

### Updating Task Progress
One of the simplest methods of tracking task progress is to specify a percentage of completion. You can enter a value between 0% (for a task that has not started) and 100% (for a task that is finished).

To update a task’s percentage of completion:

1. In the Task Name column, double-click the Website Ideas and Mockups task. The Task Information dialog box opens.
2. On the General tab, in the Percent complete box, enter 70% (see Figure 7).
3. Click the OK button. In the timescale, a progress bar is added within the Website Ideas and Mockups task bar to show progress on the task (see Figure 8).

NOTE: You can quickly set tasks to 0%, 25%, 50%, 75%, or 100% complete by selecting the tasks in the task table, and then clicking the corresponding buttons in the Schedule group on the Task tab of the Ribbon (see Figure 9).

**Working with Resources**

Resources are typically people assigned to tasks in a project. They can also include anything that is used to complete a project, such as materials or cost.

**Adding a Work Resource**

By adding resources to your project, you make them available to assign to tasks within your project.

To add a work resource:

2. In the first row, enter John Smith in the Resource Name field (see Figure 10).
3. Make sure that the Type field is set to Work.
4. Enter **JS** in the **Initials** field.
5. Enter **Programmer** in the **Group** field.
6. Enter **30** in the **Std. Rate** field. This sets the hourly rate for that worker to $30.

![Figure 10 – Work Resource in the Resource Sheet View](image)

### Changing a Resource’s Work Hours

By default, a resource’s work hours are set to the project’s work hours. You can change a resource’s work hours to reflect his or her actual work schedule.

To change a resource’s work hours:

1. In the **Resource Name** column, double-click the **John Smith** resource. The **Resource Information** dialog box opens.
2. On the **General** tab, click the **Change Working Time** button. The **Change Working Time** dialog box opens.
3. Click the **Work Weeks** tab in the lower section of the dialog box.
4. In the **Name** column, double-click the **[Default]** work week. The **Details for '[Default]'** dialog box opens (see Figure 11).
5. In the **Select day(s)** box, select Monday through Friday by clicking **Monday**, holding down the **Shift** key, and then clicking **Friday**.
6. Select the **Set day(s) to these specific working times** option.
7. Change the **From** time in the first row to **7:00 AM** and the **To** time in the second row to **4:00 PM**.
8. Click the **OK** button in each dialog box to apply the changes.

![Figure 11 – Details for '[Default]' Dialog Box](image)

### Assigning a Resource to a Task

After you add resources to your project, the next step is to assign them to tasks within your project.
To assign a resource to a task:

1. On the View tab of the Ribbon, in the Task Views group, click the Gantt Chart button to switch to the Gantt Chart view.

2. In the task table, click in the Resource Names field of the Website Ideas and Mockups task, click the down arrow that appears, and then select the check box next to John Smith to assign him to the task (see Figure 12).

   NOTE: If the Resource Names column is not displayed, use the scroll bar at the bottom of the task table, or move the separator bar between the timescale and the task table to display it.

3. A red person icon appears in the Indicators field (in the first column) of the Website Ideas and Mockups task to indicate that the resource is overallocated. To resolve the overallocation, temporarily change the Task Mode from Manually Scheduled to Auto Scheduled, and then change it back to Manually Scheduled (see Figure 13).

   NOTE: Overallocations are Project’s way of letting you know that a resource cannot complete a task in the allotted time. In this case, however, Project simply wants to extend the project duration to Monday morning.

**Scheduling**

Scheduling is a key part of project management. Project 2013 includes several scheduling enhancements that give you greater control over your schedule.

**Changing a Project’s Work Hours**

By default, a project’s work hours are set to Monday through Friday, 8:00 a.m. to 5:00 p.m., with an hour off for lunch between 12:00 p.m. and 1:00 p.m. each day. A new resource’s work hours are initially based on the project’s work hours. You can change the project’s work hours to reflect the general working days and hours of your project.
To change a project’s work hours:

2. Click the Work Weeks tab in the lower section of the dialog box.
3. In the Name column, double-click the [Default] work week. The Details for 'Default' dialog box opens (see Figure 14).
4. In the Select day(s) box, select Monday through Friday by clicking Monday, holding down the Shift key, and then clicking Friday.
5. Select the Set day(s) to these specific working times option.
6. Change the From time in the first row to 7:00 AM and the To time in the second row to 4:00 PM.
7. Click the OK button.

8. In the Change Working Time dialog box, click the Options button. The Project Options dialog box opens, displaying the Schedule options.
9. In the right pane, change the Default start time to 7:00 AM and the Default end time to 4:00 PM (see Figure 15).
10. Click the OK button in each dialog box to apply the changes.
**Setting a Scheduling Constraint**

A constraint is a restriction set on the start or finish date of a task. There are several types of constraints that can be placed on a task.

To set a scheduling constraint:

1. Make sure that the **Gantt Chart** view is displayed.
2. On the **Task** tab of the **Ribbon**, in the **Properties** group, click the **Display Task Details** button. The **Task Details Form** view displays below the **Gantt Chart** view.
3. In the **Gantt Chart** view, in the **Task Name** column of the task table, click to select the **Website Draft #1** task.
4. In the **Task Details Form** view, deselect the **Manually Scheduled** check box. This changes the task from **Manually Scheduled** to **Auto Scheduled** which is required for setting scheduling constraints.
5. In the **Constraint** section, select **Start No Earlier Than** from the **Constraint** list (see Figure 16).

![Figure 16 – Constraint List](image)

6. Set the **Date** to one day after its original start date.
7. Click the **OK** button. The start and finish dates of the **Website Draft #1** task are updated in the task table.

**NOTE:** After setting the constraint, if you change the start date to an earlier date, a warning will be issued.

**Assigning Multiple Resources to a Task**

A task can be assigned to multiple resources to reduce the amount of time needed to complete the task.

To assign multiple resources to a task:

1. First, add another work resource. On the **View** tab of the **Ribbon**, in the **Resource Views** group, click the **Resource Sheet** button to switch to the **Resource Sheet** view.
2. In the second row, enter **James Wilson** in the **Resource Name** field.
3. Make sure that the **Type** field is set to **Work**.
4. Enter **JW** in the **Initials** field.
5. Enter **Manager** in the **Group** field.
6. Enter **40** in the **Std. Rate** field. This sets the hourly rate for that worker to $40.
7. Next, on the **View** tab of the **Ribbon**, in the **Task Views** group, click the **Gantt Chart** button to switch to the **Gantt Chart** view.
8. In the **Task Name** column of the task table, click to select the **Website Draft #1** task.
9. On the **Resource** tab of the **Ribbon**, in the **Assignments** group, click the **Assign Resources** button 🌐. The **Assign Resources** dialog box opens.
10. In the **Resource Name** column, click to select the **James Wilson** resource, and then click the **Assign** button.
11. Click to select the **John Smith** resource, and then click the **Assign** button (see Figure 17).

<table>
<thead>
<tr>
<th>Resource Name</th>
<th>R/D</th>
<th>Units</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>James Wilson</td>
<td>100%</td>
<td>$3,200.00</td>
<td></td>
</tr>
<tr>
<td>John Smith</td>
<td>100%</td>
<td>$2,400.00</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 17 – Assigned Work Resources**

12. Click the **Close** button.
13. Click the exclamation icon 🔄 that appears to the left of the **Website Draft #1** cell and select the **Reduce duration but keep the same amount of work.** option as the reason for assigning two resources to the task (see Figure 18).

**Figure 18 – Reducing Task Duration**

**NOTE:** A task must be set to **Auto Scheduled** to enable this option.

**Creating a Work Exception**

In the event that a person is unable to make it to work, you can create an exception to remove that day from the person’s work hours.

To create a work exception:

1. In the **Gantt Chart** view, make a note of the week during which the **Website Draft #1** task is scheduled.
2. On the **View** tab of the **Ribbon**, in the **Resource Views** group, click the **Resource Sheet** button 📊 to switch to the **Resource Sheet** view.
3. In the **Resource Name** column, double-click the **John Smith** resource. The **Resource Information** dialog box opens.
4. On the **General** tab, click the **Change Working Time** button. The **Change Working Time** dialog box opens.
5. On the **Exceptions** tab, enter **Sick** in the first row of the **Name** column.
6. Set the **Start** date to the **Tuesday** of the week that the **Website Draft #1** task is scheduled.
7. Click the **OK** button in each dialog box.
8. On the **View** tab of the **Ribbon**, in the **Task Views** group, click the **Gantt Chart** button ![Gantt Chart button] to switch to the **Gantt Chart** view. Notice that the task has been extended to the next working day so that it can be completed since one of the two resources assigned to the task is going to miss a day.